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Google Sheets 
Enter Dates  

Instructor Information 

Instructor  Email  Office Location & Hours  
add text add text  add text 

General Information  

Description 
Master essential Google Sheets skills required to confidently organize, analyze, and present data for personal, 
academic, or professional use. This course provides comprehensive, hands-on instruction in key Google 
Sheets functionalities, ensuring you develop the tools to create well-structured spreadsheets, perform 
calculations, and manage data with precision. 

You will gain expertise in entering and formatting data, applying formulas and functions, working with tables 
and ranges, and visualizing information using charts and conditional formatting. You'll also learn to 
collaborate in real time, protect data, and automate repetitive tasks using features like filter views, pivot 
tables, and macros. 

Beyond spreadsheet basics, you’ll explore advanced techniques for summarizing information, validating 
inputs, and customizing sheets for clarity and efficiency. You’ll also learn how to prepare your files for printing, 
sharing, and long-term use in a collaborative environment. 

Whether you're tracking budgets, managing projects, or handling complex datasets, this course will equip 
you with the confidence and practical skills to use Google Sheets effectively in any context. 

Course Objectives 
This course helps learners build essential spreadsheet skills using Google Sheets to organize, analyze, and 
present data with confidence. Learners begin with the basics, entering data, formatting cells, and using 
simple formulas, then progress to functions, charts, conditional formatting, and data tools like filters and 
pivot tables. With a focus on real-world applications such as budgets, trackers, and reports, this course is 
ideal for students, educators, and professionals seeking to improve their productivity and data literacy in a 
collaborative, cloud-based environment.  

By the end of this course, learners will be able to:  

 Create, open, and organize spreadsheets using Google Sheets in a collaborative, cloud-based 
environment.  

 Enter, edit, and format data using text formatting, number formats, alignment options, and cell 
styles.  

 Perform calculations using basic formulas and built-in functions such as SUM, AVERAGE, IF, and 
COUNT.  

 Organize and analyze data with tools like sorting, filtering, conditional formatting, and data 
validation.  

 Visualize information by creating and customizing charts, including pie, column, line, and combo 
charts.  
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 Work with large datasets using freeze panes, named ranges, pivot tables, and protected ranges.  

 Import, export, and print spreadsheets while managing settings like scaling, orientation, and print 
areas.  

 Use version history, sheet customization, and collaborative tools to track changes and improve 
productivity.  

 Apply productivity techniques such as keyboard shortcuts, ARRAYFORMULA, and macros to 
streamline workflow.  

Course Materials  

Required materials  
 Computing Device 

 Internet Connection 

Optional materials  
 Headset 

Schedule  

Dates Level  

 Unit 1: Getting Started with Google Sheets 

 Unit 2: Work with Data in Google Sheets 

 Unit 3: Simple Functions and Formulas 

 Unit 4: Advanced Functions and Data Handling 

 Unit 5: Data Display and Visualization 

 Unit 6: Data Control and Automation 

Course Structure 

The course is structured to learn by doing, practice the learned skill, and then apply the skill. 

• Unit 

o Lesson 

 Learn Tasks 

 Practice Exercises 

 Practice Questions 

o Objective Assessment 

o Create Project 

Each unit contains lessons. The lessons are introduced by lesson topics where learners can understand 
through doing or learning through study materials. Each lesson concludes with a Practice Exercise that 
incorporates the tasks they learned throughout the lesson. Once they have completed the lessons in the 
unit, learners are assessed through a question-based Objective Assessment and a Create Project. 
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Weights and Grading 

Add your course weight and grading here 

Additional information and resources  

Add a subheading  
Add text. 
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Instructor Guide Overview 
Course Structure 
The course is structured to learn by doing, practice the learned skill, and then apply the skill. 

• Unit 

o Lesson 

 Learn Tasks 

 Practice Exercises 

 Practice Questions 

o Objective Assessment 

o Create Project 

Each unit contains lessons. The lessons are introduced by lesson topics where learners can 
understand through doing or learning through study materials (eBook, QuickDeck or QuickClip). 
Each lesson concludes with a Practice Exercise that incorporates the tasks they learned 
throughout the lesson. Once they have completed the lessons in the unit, learners are assessed 
through a question-based Objective Assessment and a Create Project. 

Delivery 
The course is created so it can be customized to meet the needs of the instructor and the learner.  

• Direct Instruction:  Utilize the PowerPoint presentations to introduce each lesson topic, 
then have the learners review the study materials and complete the task. 

• Flipped  Classroom:  Learners complete online lessons outside of class time. Learners 
utilize the class time to discuss learned tasks, allow learners to teach concepts, expand 
concepts through learning stations, and work on unit extension or unplugged activities. 

• Learner-Centered Approach: Use the prescriptive learning model so learners can focus 
on new skills and skip the skills they already know. Learners can work at their own pace on 
their own schedule to complete the course. Instructors support learners by utilizing the 
answer keys to identify struggles and guide learners through the solutions.   

Differentiation 
• Study Materials: Study materials are available in eBook, QuickDeck and QuickClip format. 

Each study material provides the same concepts and allows the learners to choose the 
modality that best fits their learning style. The eBook introduces concepts in bite-sized 
readings. QuickDecks display materials in a flashcard format. QuickClips provide a video 
and audio-based clip. 
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• Course Progression: Learners can complete the learn task to demonstrate understanding 
before reviewing the study materials or they can review one or all the study materials 
before attempting the learn tasks. 

• Grouping: Create groups for different learning levels or styles. Customize each group 
setting to best meet the needs of the learners. 

• Provide struggling learners with answer keys to follow step-by-step instructions to 
complete tasks and exercises. 

• Encourage learners to showcase their newly learned skills by creating additional real-world 
projects, teaching others how and why to use new skills, and exploring beyond their 
learning. 

Prepare for Delivery 
• Begin with the unit overview to understand the structure and flow of the unit, the topics 

covered, the approximate time to complete and the exam objectives reviewed. 

• Review the lesson PowerPoint Presentation to give you an in-depth look at each lesson 
topic and the comprehensive topic notes included. 

• Review the answer keys to familiarize yourself with the tasks learners will complete 
throughout the lesson. 

• Complete the lesson. 

Instructor Resources Overview 
Instructor 
Resources 
File Structure 

 Instructor Resources  
 Course Syllabus 
 Course Overview 
 Course Key Terms 
 Course Instructor Guide 
 Unit 

 Unit Assessment Answer Keys 
 Create Project 
 Objective Assessment  

 Lesson 
 Answer Keys 

 Lesson Practice Exercises 
 Learn Tasks 
 Lesson Practice Questions 

 Study Guides 
 Study Guide Complete 
 Study Guide Fill-In Explanation 
 Study Guide Fill-In Topic 

 Lesson PowerPoint Presentations 
 Unplugged Activities 
 Unit Overview 
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 Unit Learning Plan 
 Unit Key Terms 

Unit Assessment 
Answer Keys 

Each unit includes two types of assessments for learners to apply their 
knowledge. 

• Create Project – These are project prompts and sample solution 
files. Create projects also include “show me” videos for learner 
reference. You have the option to enable/disable this feature. 

• Objective Assessment – A comprehensive question and answer-
based assessment for the unit. Objective Assessments include 
“show solution” for learner reference. You have the option to 
enable/disable this feature. 

Answer Keys 
 

Documents containing answers, step-by-step instructions, and correct 
answers for Instructor reference or to offer additional support material for 
learners. 

• Learn Tasks - Each lesson topic includes an opportunity to apply 
what they have just learned in-app or by answering questions. Learn 
Tasks also include “show me” videos and “show solution” for learner 
reference. 

• Lesson Practice Exercises – End of lesson in-app or scenario-based 
assessment. Lesson Practice Exercises also include “show me” 
videos for learner reference. You have the option to enable/disable 
this feature. 

• Lesson Practice Questions – End of lesson question-based 
assessment. Lesson Practice Questions also include “show solution” 
for learner reference. You have the option to enable/disable this 
feature. 

Study Guides Printable and customizable study guides mapped to lesson topics and 
exam objectives are provided in three formats. 

• Complete- This version includes the topic and the explanation. 
• Fill-In Topic-Learners can fill in the topics as they learn or as a 

review. 
• Fill-In Explanation – This allows learners to complete the 

explanation of each lesson topic in their own words and images. 
Learning Plan Customizable unit learning plan outlining the objectives and topics 

covered, essential questions, learning targets, methods and materials, 
extension activities, formative and summative assessments, mapping to 
STEAM, Work Readiness, 5 C’s, and Bloom’s Taxonomy Levels.  

Lesson 
PowerPoint 

A PowerPoint Presentation that complements the lesson. Each lesson topic 
is included in the presentation as well as comprehensive speaker notes. 

Unplugged 
Activities 

A variety of activities and necessary resources to get learners off the 
computers while still reinforcing unit learning objectives. 

Unit Key Terms A comprehensive list of key terms throughout the unit. 
Unit Overview A spreadsheet containing the overview of the flow of the unit that includes 

lesson topics, certification objectives mapping, and approximate timings for 
self-paced and instructor-led scenarios. 
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Google Sheets Learning Plan 

Unit 1: Getting Started with Google Sheets 
Instructor: Class: Duration: 5-10 hours 
Unit Objectives:  
Learners will explore the Google Sheets interface, manage worksheets, adjust rows and columns, and utilize 
foundational features such as import, version history, and print setup to confidently navigate and format 
spreadsheets. 

Essential Questions: 
• How do I navigate and customize the Google Sheets interface to suit my workflow? 
• What tools help manage and organize spreadsheet content efficiently? 
• In what ways can I view, edit, and share spreadsheet versions and layouts? 

Learning Targets: 
I will understand how the Google Sheets window, toolbar, and workspace are organized, 
so I can confidently locate tools and customize my workspace for efficiency. 
I know I succeeded when I can identify key interface elements and adjust workspace settings. 

Methods and Materials: 
• Lectures 
• Reading 
• Videos 
• Hands-on activities 
• Creating 
• Analyzing  
• Discussing 
• Teaching 

Formative Assessments: 
• Learn Tasks 
• Practice Exercise 
• Practice Questions 

 

Summative Assessments: 
• Objective Assessment 
• Create Project 

STEAM 
☒ Science 
☒ Technology 
☒ Engineering 
☒ Art 
☒ Math 

Work Readiness 
☒ Communication 
☒ Problem-solving 
☒ Teamwork 
☒ Work ethic 
☒ Empathy 
☒ Conflict resolution 
☒ Active listening 
☒ Time management 
☒ Adaptability 
☒ Reading 
☒ Mathematics 

5 C’s 
☒ Critical Thinking 
☒ Creativity 
☒ Communication 
☒ Collaboration 
☒ Citizenship 

Blooms Level 
☒ Remembering 
☒ Understanding 
☒ Applying  
☒ Analyzing 
☒ Evaluating  
☒ Creating 
 

Learning Activities 
Domain Time Allowed Content 

Lesson 1: Sheets Interface 60-130 minutes • Sheets Window 
• Customize the Workspace 
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• Toolbar 
• Create a Spreadsheet 
• Open a Spreadsheet 
• Make Available Offline 
• Import Files 

Lesson 2: Manage Files 50-100 minutes • Version History 
• Edit History 
• Share Workbooks 
• Define Print Area 
• Print 

Lesson 3: Customize Worksheets 65-145 minutes • Zoom 
• Freeze Titles 
• Customize Sheets 
• Sheet Color 
• Rename a Worksheet 
• Move and Duplicate a Worksheet 
• Hide and Show Worksheets 
• Edit Multiple Worksheets 

Lesson 4: Worksheet Structure 65-145 minutes • Insert Cells, Rows and Columns 
• Delete Cells, Rows and Columns 
• Hide and Show Rows and Columns 
• Select a Row or Column 
• Row Height  
• Column Width 
• Merge and Unmerge Cells 
• Identify Row and Column Names 

 

Warm-Up Activities 
1. Without observing a device, list or sketch everything you remember viewing on the Google Sheets screen. 

Bonus: What tools do you think are most used? 
2. Which Tool Would You Use? 

Imagine someone needs to write down which tool or menu you think they should use. 
• Freeze a row 
• Print part of a spreadsheet 
• Undo a change 

3. Organizer Challenge (Verbal or Paper) 
Describe (or draw on paper) how you would organize 3 different spreadsheets. What tabs, colors, or 
column names would you use? 
• A class gradebook 
• A budget 
• A sign-up sheet 

Extension Activities 
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1. Create a portfolio for the course. Portfolios should include evidence of work, reflect on learned skills and 
how you can incorporate the skills in a current or future project. This is an ongoing extension activity. 
Continue to add to the portfolio throughout the course. 

2. Select one topic learned throughout the unit then create an instructional video, tutorial, lecture, or hands-
on activity to teach others about the skill. 

3. Design a 1-page help sheet that explains how to open, import, print, and access version history in Google 
Sheets. Include screenshots and step-by-step instructions. 

4. Create a workbook with at least five worksheets. Name them, assign colors, and duplicate one of them. 
Share a summary of your organization choices. 

5. Record a short screen recording teaching someone how to insert, resize, and merge columns and rows in a 
spreadsheet. 

 

Unit Evaluation and Reflection 
What went well What needs to change 
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Unit 1 Sheets Interface Learn Tasks 
Lesson Topic Assessment Details Answer Key File Name 

Sheets Window Select the area on the Sheets 
Window to complete the 
following: 
1) View options like 

opening, saving, and 
printing your document 

2) Share your document 
with others 

3) Add a new sheet within 
the same document 

4) Navigate between sheets 

• File 
• Share 
• Add Sheet 
• Sheet Tabs 

 

 

Customize the 
Workspace 

Display the grid. View menu > Gridlines > 
Show gridlines 

 

Toolbar Select the button on the 
toolbar to complete each of 
the following: 
1) Bold 
2) Italic 
3) Fill color 
4) Insert chart 
5) Create a filter 
6) Zoom 

 

 

 

 

 

Create a 
Spreadsheet 

Create a new spreadsheet. Open your web browser > 
Google.com > Google Apps 
> Sheets >Blank 
spreadsheet (+) button  

 

Open a 
Spreadsheet 

Open the Example 
spreadsheet. 

Open your web browser > 
Google.com > Google Apps 
> Sheets > Open a sheet 

 

Make Available 
Offline 

Make the spreadsheet 
available offline. 

File menu > Make available 
offline > Toggle the switch 
to enable offline access > 
Done 

 

Import Files Import a CSV file named 
AdditionalSalesData.csv and 
append its data to the 
existing dataset. 

File menu > Import > 
Upload > Select 
AdditionalSalesData.csv > 
Append to current sheet > 
Import data > Done 

Import Files.xlsx 
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Unit 1 Sheets Interface Practice Exercise 
Assessment Details Answer Key File Name 

1) Create a new spreadsheet. 
2) Rename the spreadsheet to 

Onboarding Tracker. 
3) Locate the following: 

• Toolbar 
• Formula bar 
• Sheet tab area. 

4) Change the zoom level to 125%. 
5) Identify the buttons for the following: 

• Inserting a chart 
• Changing font size 
• Changing text color 

6) Import the file named 
departments.csv into a new sheet 

7) Rename the new sheet to New 
Departments. 

8) On the first sheet, in cell A1, enter the 
text “Welcome to Your New Role!” 

9) View the option to make the file 
available offline. 

1) File > New > Spreadsheet 
2) File > Rename > Onboarding 

Tracker 
3) Identify: 

• Toolbar at the top 
• Formula bar below the 

toolbar 
• Sheet tab area at the bottom 

4) View > Zoom > 125% 
5) Hover over the toolbar to 

identify: 
• Insert chart 
• Font size 
• Text color 

6) File > Import > Upload > 
departments.csv. Choose Insert 
new sheet(s) 

7) Sheet tab > Rename > New 
Departments 

8) In cell A1, enter “Welcome to 
Your New Role!” and select the 
Enter key 
 

Departments.
csv 
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Unit 1 Sheets Interface Practice Questions 
 
You’ve just started working as an intern for a marketing firm called BrightLeaf Promotions. On your 
first day, your manager asks you to set up and organize your workspace in Google Sheets so you 
can track campaign data. You’ll need to get familiar with the Sheets interface, customize it for your 
workflow, and import some files from clients to begin working. 

 
1) Which of the following best describes what happens when you select the Explore button in the 

lower-right corner of the Sheets window? 
a) It opens a panel that displays file versions and edit history 
b) It displays formatting options for headers and footers 
c) It provides automatic data analysis suggestions, charts, and answers to questions 

(correct) 
d) It lets you publish the file to the web 

 
Explanation: The Explore tool provides quick insights into your data, including charts and 
suggested formulas based on the contents of your spreadsheet. It’s a helpful feature located in 
the bottom-right corner of the Sheets window. 

 
2) Fill in the blank with the correct words.  

The Toolbar (correct) in Google Sheets provides quick access to icons for tasks like bold text, 
text alignment, and inserting links. 
• Toolbar 
• Sidebar 
• Menu bar 
• Formula bar 

 
Explanation: The toolbar sits below the menu bar and contains visual icons for commonly used 
commands, helping users format and edit their spreadsheets more efficiently. 

 
3) The Make available offline option can only be turned on for a specific file, not for all Google 

Sheets documents. 
• True  
• False (correct) 

 
Explanation: You can enable offline access for all your Google Drive files (including all Sheets) 
through your Drive settings. You can also enable it for individual files. 

 
4) You’re trying to open a .csv file your manager emailed you. What’s the best way to do this in 

Google Sheets? 
a) Right-click on the file and select Publish to the Web 
b) Use File > Download > Upload 
c) Select File > Import > Upload, then open the .csv file (correct) 
d) Select Edit > Paste Special > Paste values only 

 
Explanation: To import a file like a CSV, you should go to File > Import > Upload. From there, you 
can open and import data from a file stored on your computer or Google Drive. 
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5) Match the steps in the correct order to create a new blank spreadsheet from Google Drive. 
a) Step 1 
b) Step 2 
c) Step 3 

 
Step 1 (correct) Select New 
Step 2 (correct) Choose Google Sheets 
Step 3 (correct) Select Blank Spreadsheet 

 
 
 
 

14



15



Sheets Interface 
Unit 1: Getting Started with Google Sheets
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Sheets Window 

• Main work area including actionable menu items
• Has File tab, Share button, Add Sheet sign, Edit, View

and Insert tabs
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Customize the Workspace 

• Use the View menu to show 
or hide gridlines

• Select the Formula bar to 
view and edit formulas in cells
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Toolbar 

Contains buttons, menus with functions to format 
spreadsheet and data 
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Create a Spreadsheet 

Open browser > Google Sheets website > Start a new 
spreadsheet section > Blank spreadsheet (+) button or 
template
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Open a Spreadsheet 

Access spreadsheets on the Sheets homepage after sign-in
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Make Available Offline

• Install Google Chrome browser > Sign in > Settings gear
icon > Check Offline

• Edited sheets will sync when internet connection is 
restored 
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Import Files 

• From device: File > Import >
Upload > Select a file from
your device > Choose options
> Import Data

• From Google Drive: Import >
My Drive > Choose options >
Import data
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Lesson 1 Sheets Interface  
Study Guide Complete  

Topic   Explanation   
Sheets Window 
Use Sheets Window  Has File tab, Share button, Add Sheet sign, Edit, View and Insert 

tabs. 
Add Sheet Sign To add a new sheet within the same document. 

Navigation  Moving around within the Google Sheets window to access different 
features.  

File Tab  A menu at the top left corner that lets you open, save, and print 
documents.  

Share Button  An option to select that lets you distribute your document to others 
and set their permissions.  

Customize the Workspace  
Show Gridlines  View menu > Select Show > Select Gridlines option.  

Hide Gridlines  View menu > Select Show > Deselect Gridlines option.  

Show Formula Bar  View menu > Select Show > Select Formula bar.   

Hide Formula Bar  View menu > Select Show > Deselect Formula bar.  

Gridlines  The borders that define the boundaries of cells in a spreadsheet, 
helping to visually separate and organize data.   

Formula Bar   The area in Google Sheets where you can view and edit the formula 
or content of the selected cell.   

Display Settings   Options that control the appearance of the workspace, such as 
showing or hiding elements like gridlines and the formula bar.   

Toolbar 
Format Text Select the buttons for Bold, Italic, or Underline. 

Change Cell Color Select the Fill color (paint bucket) icon. 

Insert Chart Select the Insert chart button. 

Sort Data Select the button with the Create a filter (funnel) icon. 

Change View Select the Zoom drop-down menu to select the zoom size.  

Toolbar  The set of buttons and menus at the top of the screen in Google 
Sheets.  

Format  To change the appearance of text or cells, like making the text bold 
or changing a cell’s color.  

Insert  To add something into your spreadsheet, like a chart or a picture.  

Sort  To arrange data in a specific order, like alphabetically or by number.  

Create a Spreadsheet 
Create a Spreadsheet Select Blank spreadsheet (+) button or template in Start a new 

spreadsheet section. 
Name a Spreadsheet Select Untitled spreadsheet text at top left corner and enter.  

Spreadsheet  A digital document where you can organize data in rows and 
columns.  

Browser  A software application used to access the internet.  

Document  A file that contains information, such as a spreadsheet.  

Title  The name you give to your spreadsheet to identify it.  
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Open a Spreadsheet 
Open a Spreadsheet 1. Open web browser/Sheets website and sign in. 

2. Access spreadsheets on the Sheets homepage. 
Access  To open or retrieve a document or file.  

Homepage  The main screen you can view when you first open a website or 
application.  

Sign In  To enter your username and password to access your account.  

Search Bar  A tool that helps you browse and select files from your storage.  

Make Available Offline   
Set Up Offline Mode  Install Google Chrome browser > Sign in to account.  

Enable Offline Mode  In Google Drave > Settings gear icon > Check Offline > Files start 
downloading.  

Access Google Sheets 
Offline  

1. Open Google Sheets in browser while online to allow sync.  
2. Once downloaded, access through app.  

Edit and Sync Changes  Edit as usual, sync will be automatic when internet connection is 
restored.  

Manage Offline Files  Select or deselect the offline option in the file's Settings.  

Offline Mode   The ability to use a service without an internet connection.   

Sync   To match data, ensuring that files are up-to-date across devices.   

Google Chrome   A web browser required for enabling offline access in Google Drive.   

Google Drive   A file storage service that includes Google Docs, Sheets, and other 
apps.   

Import Files  
Import Files  Open Google Sheets website > Sign in > Create new sheet > Select 

import options.  
Import From Device  File > Import > Upload > Select a file from your device > Choose 

options > Import Data.  
Import From Google Drive  Import > My Drive > Choose options > Import data.  

Import Options  • Create a new spreadsheet.  
• Insert new sheet(s).   
• Replace spreadsheet.  

Import Options  • Append to current sheet.   
• Replace data starting at selected cell.   

Import   To bring data into a software application from another source.   

File Type   The format of a file, such as .xls, .csv, or .txt.   

Append   To add data to the end of existing content.   
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Lesson 1 Sheets Interface  
Study Guide Fill-In Explanation  

Topic   Explanation   
Sheets Window 
Use Sheets Window   

Add Sheet Sign  

Navigation   

File Tab   

Share Button   

Customize the Workspace  
Show Gridlines   

Hide Gridlines   

Show Formula Bar   

Hide Formula Bar   

Gridlines   

Formula Bar    

Display Settings    

Toolbar 
Format Text  

Change Cell Color  

Insert Chart  

Sort Data  

Change View  

Toolbar   

Format   

Insert   

Sort   

Create a Spreadsheet 
Create a Spreadsheet  

Name a Spreadsheet  

Spreadsheet   

Browser   

Document   

Title   

Open a Spreadsheet 
Open a Spreadsheet 1.  

Access   

Homepage   

Sign In   
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Search Bar   

Make Available Offline   
Set Up Offline Mode   

Enable Offline Mode   

Access Google Sheets 
Offline  

 

Edit and Sync Changes   

Manage Offline Files   

Offline Mode    

Sync    

Google Chrome    

Google Drive    

Import Files  
Import Files   

Import From Device   

Import From Google Drive   

Import Options   

Import Options   

Import    

File Type    

Append    
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Lesson 1 Sheets Interface  
Study Guide Fill-In Topic  

Topic   Explanation   
Sheets Window 
 Has File tab, Share button, Add Sheet sign, Edit, View and Insert 

tabs. 
 To add a new sheet within the same document. 

 Moving around within the Google Sheets window to access different 
features.  

 A menu at the top left corner that lets you open, save, and print 
documents.  

 An option to select that lets you distribute your document to others 
and set their permissions.  

Customize the Workspace  
 View menu > Select Show > Select Gridlines option.  
 View menu > Select Show > Deselect Gridlines option.  
 View menu > Select Show > Select Formula bar.   
 View menu > Select Show > Deselect Formula bar.  
 The borders that define the boundaries of cells in a spreadsheet, 

helping to visually separate and organize data.   
 The area in Google Sheets where you can view and edit the formula 

or content of the selected cell.   
 Options that control the appearance of the workspace, such as 

showing or hiding elements like gridlines and the formula bar.   
Toolbar 
 Select the buttons for Bold, Italic, or Underline. 

 Select the Fill color (paint bucket) icon. 

 Select the Insert chart button. 

 Select the button with the Create a filter (funnel) icon. 

 Select the Zoom drop-down menu to select the zoom size.  

 The set of buttons and menus at the top of the screen in Google 
Sheets.  

 To change the appearance of text or cells, like making the text bold 
or changing a cell’s color.  

 To add something into your spreadsheet, like a chart or a picture.  

 To arrange data in a specific order, like alphabetically or by number.  

Create a Spreadsheet 
 Select Blank spreadsheet (+) button or template in Start a new 

spreadsheet section. 
 Select Untitled spreadsheet text at top left corner and enter.  

 A digital document where you can organize data in rows and 
columns.  

 A software application used to access the internet.  

 A file that contains information, such as a spreadsheet.  

 The name you give to your spreadsheet to identify it.  
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Open a Spreadsheet 
 1. Open web browser/Sheets website and sign in. 

2. Access spreadsheets on the Sheets homepage. 
 To open or retrieve a document or file.  

 The main screen you can view when you first open a website or 
application.  

 To enter your username and password to access your account.  

 A tool that helps you browse and select files from your storage.  

Make Available Offline   
 Install Google Chrome browser > Sign in to account.  
 In Google Drave > Settings gear icon > Check Offline > Files start 

downloading.  
 1. Open Google Sheets in browser while online to allow sync.  

2. Once downloaded, access through app.  
 Edit as usual, sync will be automatic when internet connection is 

restored.  
 Select or deselect the offline option in the file's Settings.  
 The ability to use a service without an internet connection.   
 To match data, ensuring that files are up-to-date across devices.   
 A web browser required for enabling offline access in Google Drive.   
 A file storage service that includes Google Docs, Sheets, and other 

apps.   
Import Files  
 Open Google Sheets website > Sign in > Create new sheet > Select 

import options.  
 File > Import > Upload > Select a file from your device > Choose 

options > Import Data.  
 Import > My Drive > Choose options > Import data.  
 • Create a new spreadsheet.  

• Insert new sheet(s).   
• Replace spreadsheet.  

 • Append to current sheet.   
• Replace data starting at selected cell.   

 To bring data into a software application from another source.   
 The format of a file, such as .xls, .csv, or .txt.   
 To add data to the end of existing content.   
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Unit 1 Create Project 
This simulated Create Project allows the application and demonstration of new knowledge and 
skills.  

1. Open Google Sheets and create a new spreadsheet. 

2. Rename the worksheet to Employee Directory. 

3. Customize the workspace by minimizing the menu and expanding the formula bar. 

4. Use the toolbar to bold the text in cell A1. 

5. In cell A1, enter “Employee Name”. 

6. In cell B1, enter “Department”. 

7. In cell C1, enter “Start Date”. 

8. Save the spreadsheet to your Google Drive and ensure it is available offline. 

9. Use the Import function to bring in data from a CSV file named departments.csv. 

10. Change the sheet color of the active worksheet to a light blue. 

11. Freeze the first row of the worksheet. 

12. Zoom the spreadsheet view to 125%. 

13. Insert a new row above row 1. 

14. Merge cells A1 through C1 and enter “Company Staff List”. 

15. Adjust the row height of row 1 to 40. 

16. Adjust the column width of column A to 200. 

17. Duplicate the current worksheet and rename the copy to Staff 2025. 

18. Hide the original Employee Directory worksheet. 

19. Insert a new column between columns B and C. 

20. In the new column, enter “Job Title” in cell C1. 

21. Delete column B (Department). 

22. Show the hidden Employee Directory worksheet. 

23. Use the Version History feature to name the current version Post-Import Edits. 
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Unit 1 Objective Assessment 
 

1) You’re working in Google Sheets and want to quickly navigate between rows, columns, and the 
formula bar. Which part of the interface helps you do this? 

a) Toolbar 
b) Sheets Window (correct) 
c) Zoom Control 
d) Workspace Control 
 
Explanation: The Sheets Window is the main working area where rows, columns, and cells are 
displayed, allowing navigation and interaction. 

 

2) To rearrange the shortcut buttons at the top of your screen, which feature would you adjust? 

a) Customize the Workspace (correct) 
b) Sheets Window 
c) Toolbar 
d) Zoom Control 

 
Explanation: Customize the Workspace allows you to show, hide, or reorder toolbar elements 
and panes. 
 

3) The Toolbar contains buttons for formatting, inserting charts, and applying functions. 

• True (correct) 
• False 
 
Explanation: The Toolbar provides quick access to commonly used commands like formatting 
and data tools. 
 

4) Fill in the blank with the correct word. 
To begin working in Sheets, you first need to create (correct) a spreadsheet. 

• create 
• format 
• save 
• copy 
 
Explanation: You need to create a spreadsheet before you can enter or edit any data. 

 

5) You need to access a spreadsheet you worked on last week. What’s the most direct action? 

a) Open a Spreadsheet (correct) 
b) Create 
c) Import Files 
d) Save 
 
Explanation: To access existing work, you open a spreadsheet from your drive or a shared 
location. 
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6) When working offline is enabled, you can access your spreadsheets without an internet 
connection. 

• True (correct) 
• False 
 
Explanation: The Make Available Offline feature lets you work on files without internet access. 
 

7) Which action would you use to bring in an Excel file to work with it in Google Sheets? 

a) Export as PDF 
b) Share a File 
c) Import Files (correct) 
d) Edit History 

 
Explanation: Importing allows you to open and convert Excel files into editable Sheets 
documents. 
 

8) Which feature allows you to view changes made to the entire spreadsheet over time? 

a) Edit History 
b) Version History (correct) 
c) Comment History 
d) Import Files 

 
Explanation: Version History provides a timeline of all edits made to the spreadsheet. 
 

9) Fill in the blank with the correct word.  
To add space for more content in your spreadsheet, you might insert cells (correct), rows, or 
columns. 

• cells 
• tabs 
• menus 
• tables 
 
Explanation: Inserting cells, rows, or columns expands the space in your spreadsheet layout. 

 

10) Deleting rows and columns will permanently remove the data they contain. 

• True (correct) 
• False 
 
Explanation: When you delete rows or columns, their content is also removed from the 
spreadsheet. 

 

11) What action allows you to temporarily remove a row or column from view without deleting it? 

a) Select 
b) Format 
c) Hide (correct) 
d) Merge 

 
Explanation: Hiding lets you temporarily remove rows/columns from view while keeping the 
data intact. 

 

32



12) Fill in the blank with the word. 
To perform an action on an entire column, you must first select (correct) it. 

• select 
• delete 
• hide 

 
Explanation: Selecting the column activates it for formatting or editing. 
 

13) A column appears too narrow. What should you do to make the content more visible? 

a) Adjust Zoom 
b) Customize Workspace 
c) Resize Column Width (correct) 
d) Freeze Titles 

 
Explanation: Widening the column makes more content visible and improves readability. 
 

14) Merging cells combines two or more cells into one larger cell. 

• True (correct) 
• False 
 
Explanation: Merging is useful for headers and visual organization. 
 

15) Fill in the blank with the correct word.  
Column names are identified using letters (correct). 

• letters 
• numbers 
• names 
• symbols 

 
Explanation: Columns are labeled with letters (A, B, C…), while rows use numbers. 
 

16) Which tool helps you track who made changes to a specific cell? 

a) Spell Check 
b) Edit History (correct) 
c) Version History 
d) Import Files 

 
Explanation: Edit History allows you to view changes made to individual cells. 
 

17) You can export a spreadsheet as a PDF for sharing or printing. 

• True (correct) 
• False 
 
Explanation: Exporting as PDF creates a fixed layout version of the spreadsheet. 
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18) Fill in the blank with the correct word. 
A teacher wants to share results with parents. They should prepare the spreadsheet for 
distribution (correct). 

• distribution 
• editing 
• commenting 
• versioning 

 
Explanation: Presentation Distribution involves preparing a clean, readable version for others. 
 

19) Fill in the blank with the correct words. 
To avoid printing extra data, you should define the Print Area (correct) before printing. 

• Zoom Level 
• Print Area 
• Theme 
• Worksheet 
 
Explanation: Defining the print area ensures only relevant cells are printed. 
 

20) Adjusting the Zoom level affects how the spreadsheet appears, but not the data itself. 

• True (correct) 
• False 
 
Explanation: Zoom changes the display scale but does not affect content. 
 

21) What feature keeps your header row visible as you scroll down the sheet? 

a) Freeze Titles (correct) 
b) Zoom 
c) Select Range 
d) Print Range 

 
Explanation: Freezing titles keeps headers in place while scrolling. 
 

22) Which action helps you color-code different sheets for straightforward navigation? 

a) Customize Sheets 
b) Sheet Color (correct) 
c) Rename Sheet 
d) Customize Workspace 

 
Explanation: Applying color to sheet tabs helps organize your workbook visually. 
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Unit 1 Key Terms   

Term   Definition   
Access  To open or retrieve a document or file.  

Append  To add data to the end of existing content.  

Audit  To examine and verify data or records for accuracy.  

Backup  A copy of data stored separately for safety and recovery purposes.  

Browser  A software application used to access the internet.  

Cell Reference  The combination of a column letter and a row number used to identify a 
specific cell.  

Cloud Storage  Online repository services that allow you to save and access files over the 
internet.  

Column  A vertical line of cells in a spreadsheet, labeled with letters.  

Column Letter  The character at the top of each column that identifies it.  

Column Width  The horizontal size of a column in a spreadsheet.  

Confirmation Dialog 
Box  

A pop-up window that asks you to verify an action.  

Context  The background or surrounding information that helps make sense of the 
data.  

Context Menu  A list that appears upon right-clicking, offering additional options and 
actions.  

Customize  To modify something to suit a particular individual or task.  

Delete  To remove a cell, row, or column from the spreadsheet.  

Dialog Box  A small window that prompts the user to enter information or make a 
selection.  

Display Settings  
Options that control the appearance of the workspace, such as showing or 
hiding elements like gridlines and the formula bar.  

Distribute  To share or deliver information to a group of people.  

Document  A file that contains information, such as a spreadsheet.  

Dropdown Menu  A list of options that appear when you select an icon or its down arrow.  

Duplicate  To create an exact copy of something.  

Edit History  A record of all changes made to a specific cell, including who made the 
changes and when.  

File Tab  A menu at the top left corner that lets you open, save, and print documents.  

File Type  The format of a file, such as .xls, .csv, or .txt.  

Fit to Data  An option that automatically adjusts the row or column size to match the 
content within it.  
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Format  
To change the appearance of text or cells, like making the text bold or 
changing a cell’s color.  

Formatting  The arrangement and style of text and data in a document.  

Formula Bar  
The area in Google Sheets where you can view and edit the formula or 
content of the selected cell.  

Freeze  To keep specific rows or columns visible while scrolling through a 
spreadsheet.  

Google Chrome  A web browser required for enabling offline access in Google Drive.  

Google Drive  A file storage service that includes Google Docs, Sheets, and other apps.  

Gridlines  
The borders that define the boundaries of cells in a spreadsheet, helping to 
visually separate and organize data.  

Header  A row or column that contains labels for the data in the spreadsheet.  

Hide  To remove the whole worksheet or part of a worksheet (rows and columns) 
from view without deleting it.  

Highlight  To mark a section of text or data with a distinct color.  

Homepage  The main screen you can view when you first open a website or application.  

Import  To bring data into a software application from another source.  

Insert  To add new cells, rows, or columns to a spreadsheet.  

Magnification  The action or process of enlarging or reducing the view of an object.  

Merge  To combine multiple cells into one larger cell.  

Minimize  To reduce something to the smallest possible size or amount.  

Navigate  To move around within a spreadsheet to locate specific data.  

Navigation  
Moving around within the Google Sheets window to access different 
features.  

Offline Mode  The ability to use a service without an internet connection.  

Palette  A range of colors or options available for selection.  

Permissions  Settings that determine what actions users can perform on a shared 
document.  

Print  To produce a physical copy of a document from a computer.  

Print Area  The specific range of cells selected to be printed.  

Range  A group of selected cells in a spreadsheet.  

Rename  To give something a new title.  

Restore  To revert a document to a previous state.  

Row  A horizontal line of cells in a spreadsheet, labeled with numbers.  

Row Height  The vertical size of a row in a spreadsheet.  

Row Number  The digit on the left side of each row that identifies it.  
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Scale  Adjusting the size of the content to fit on the printed page.  

Scroll  To move up, down, or across a screen to view different parts of a document.  

Search Bar  A tool that helps you browse and select files from your storage.  

Select  To highlight a row, column, or cell to perform actions on it.  

Share Button  
An option to select that lets you distribute your document to others and set 
their permissions.  

Sheet Tab  The labeled tag at the bottom of the Google Sheets window that represents 
each page in the document.  

Shift  To move existing cells to make room for new ones.  

Show  To make a hidden worksheet visible again.  

Sign In  To enter your username and password to access your account.  

Sort  To arrange data in a specific order, like alphabetically or by number.  

Spreadsheet  A digital document where you can organize data in rows and columns.  

Sync  To match data, ensuring that files are up-to-date across devices.  

Timeline  A chronological list of events or changes.  

Title  The name you give to your spreadsheet to identify it.  

Toolbar  A set of icons and options at the top of the screen that allows you to perform 
different tasks.  

Unmerge  To split a joined cell back into the original separate cells.  

Version History  A feature that tracks and stores previous copies of a document.  

Zoom  To change the magnification level of the spreadsheet view.  
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Unit 1: Unplugged Activities 
Instructor Guide 
  

Instructions 
Below are a variety of offline activities to choose from to support learning in the unit. Choose activities 
to enhance learning in the classroom.  

Activity 1: Word Search 
With Words - Use this word search to reinforce the key terms in the unit. An answer key is provided.  

With Clues - Use this word search to challenge learners to find key terms in the unit using clues. An 
answer key is provided. 

Activity 2: Crossword Puzzle 
Solve the crossword puzzle by reading clues and filling in the answers with key terms from the unit.  A 
solution key is provided. 

Activity 3: Build a Sheet Challenge 
Learners will understand the purpose and layout of the Sheets interface by creating a paper-based 
model of the workspace and discussing key tools. 

Activity 4: Spreadsheet Simulator  
Learners will simulate the structure and function of a spreadsheet using classmates or paper tiles to 
physically act out row/column actions like inserting, deleting, hiding, resizing, merging, and naming. 
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Unit 1 Unplugged Activity 
 

Activity 1: Word Search   

With Words - Use this word search to reinforce the key terms from the unit. An answer key is provided.  

With Clues - Use this word search to challenge learners to find key terms from the unit using clues. 
An answer key is provided. 
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Unit 1 Word Search with Words 
Complete the following word search by finding and circling all the words in the box below the puzzle. 
Words can be in any direction.  

 

ACCESS  
APPEND  
AUDIT  
BACKUP  
BROWSER  
COLUMN  
CONTEXT  

 

CUSTOMIZE  
DELETE  
DISTRIBUTE  
DOCUMENT  
DUPLICATE  
EXPORT  
FORMATTING 

FREEZE  
GRIDLINES  
HEADER  
HIDE  
HIGHLIGHT  
HOMEPAGE  
IMPORT  

INSERT  
MAGNIFICATION  
MARGINS  
MERGE  
MINIMIZE  

      NAVIGATE 

T S Z X O C T M Q M N C O Q F J D P M X C Z W
Y S B X G S V W E C A J B K U U Q Q I G U D H
L Q U N H H R G D F Z G Y M F D W V T X T I F
N U R R A X R R K C B I N D I S P J D H F S N
D A E I U E T D Y Z H L I I A N Y S F W J T U
J W V E M F Y Y U W I C I B F I I E O Z C R S
N B S I I K O P K P L T G O R I Z M V P I I J
S L F Q G D Q O E X L J H W O B C V I Z N B W
S M L U K A J M O N D I R L G R S A F Z P U X
T K C I Y S T Z G N A K C K Z O V D T H E T D
O N V H N P U E F A R B A A E W G Q K I I E I
G D Q M N S B A C K U P P G T S T B V D O D G
R Z E M G E E X L P W W A F R E E Z E E P N E
I O H T W D Z R O T I P A T J R Z J C Z I H X
D K U I P L S R T D E O N K U O C O N T E X T
L Y W L G N E V U M I E V S D E L E T E N B L
I X M M I H D T O G M E S E S U C A G M Z A Z
N G A G T E L H T U I E B T C E M P U T M M T
E U R P R A I I C K C F G C V R X L F C A W M
S A E U M D P O G C Z G J U O D O P M W U O V
M O Y E Z E D X A H Y X I F D C L D O F D V V
O I M P O R T C U S T O M I Z E A H D R I J R
V J S N U V J S S E F Y J H A P P E N D T A E
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Unit 1 Word Search Solution Key 

 
 

 

 

T S Z X O C T M Q M N C O Q F J D P M X C Z W
Y S B X G S V W E C A J B K U U Q Q I G U D H
L Q U N H H R G D F Z G Y M F D W V T X T I F
N U R R A X R R K C B I N D I S P J D H F S N
D A E I U E T D Y Z H L I I A N Y S F W J T U
J W V E M F Y Y U W I C I B F I I E O Z C R S
N B S I I K O P K P L T G O R I Z M V P I I J
S L F Q G D Q O E X L J H W O B C V I Z N B W
S M L U K A J M O N D I R L G R S A F Z P U X
T K C I Y S T Z G N A K C K Z O V D T H E T D
O N V H N P U E F A R B A A E W G Q K I I E I
G D Q M N S B A C K U P P G T S T B V D O D G
R Z E M G E E X L P W W A F R E E Z E E P N E
I O H T W D Z R O T I P A T J R Z J C Z I H X
D K U I P L S R T D E O N K U O C O N T E X T
L Y W L G N E V U M I E V S D E L E T E N B L
I X M M I H D T O G M E S E S U C A G M Z A Z
N G A G T E L H T U I E B T C E M P U T M M T
E U R P R A I I C K C F G C V R X L F C A W M
S A E U M D P O G C Z G J U O D O P M W U O V
M O Y E Z E D X A H Y X I F D C L D O F D V V
O I M P O R T C U S T O M I Z E A H D R I J R
V J S N U V J S S E F Y J H A P P E N D T A E
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Unit 1 Word Search with Clues 
Complete the following word search by finding and circling the words that fit the clues below. Words can 
be in any direction.  

 

 
  

T S Z X O C T M Q M N C O Q F J D P M X C Z W
Y S B X G S V W E C A J B K U U Q Q I G U D H
L Q U N H H R G D F Z G Y M F D W V T X T I F
N U R R A X R R K C B I N D I S P J D H F S N
D A E I U E T D Y Z H L I I A N Y S F W J T U
J W V E M F Y Y U W I C I B F I I E O Z C R S
N B S I I K O P K P L T G O R I Z M V P I I J
S L F Q G D Q O E X L J H W O B C V I Z N B W
S M L U K A J M O N D I R L G R S A F Z P U X
T K C I Y S T Z G N A K C K Z O V D T H E T D
O N V H N P U E F A R B A A E W G Q K I I E I
G D Q M N S B A C K U P P G T S T B V D O D G
R Z E M G E E X L P W W A F R E E Z E E P N E
I O H T W D Z R O T I P A T J R Z J C Z I H X
D K U I P L S R T D E O N K U O C O N T E X T
L Y W L G N E V U M I E V S D E L E T E N B L
I X M M I H D T O G M E S E S U C A G M Z A Z
N G A G T E L H T U I E B T C E M P U T M M T
E U R P R A I I C K C F G C V R X L F C A W M
S A E U M D P O G C Z G J U O D O P M W U O V
M O Y E Z E D X A H Y X I F D C L D O F D V V
O I M P O R T C U S T O M I Z E A H D R I J R
V J S N U V J S S E F Y J H A P P E N D T A E
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Unit 1 Word Search Clues 

WORD CLUE 
 To open or retrieve a document or file.  
 To add data to the end of existing content.  
 To examine and verify data or records for accuracy.  
 A copy of data stored separately for safety and recovery purposes.  
 A software application used to access the internet.  
 A vertical line of cells in a spreadsheet, labeled with letters.  
 The background or surrounding information that helps make sense of the data.  
 To modify something to suit a particular individual or task.  
 To remove a cell, row, or column from the spreadsheet.  
 To share or deliver information to a group of people.  
 A file that contains information, such as a spreadsheet.  
 To create an exact copy of something.  
 To save data in a different format for use in another application or system.  

 To change the appearance of text or cells, like making the text bold or changing a 
cell’s color.  

 The arrangement and style of text and data in a document.  
 To keep specific rows or columns visible while scrolling through a spreadsheet.  

 The borders that define the boundaries of cells in a spreadsheet, helping to visually 
separate and organize data.  

 A row or column that contains labels for the data in the spreadsheet.  
 To remove the whole worksheet or part of a worksheet (rows and columns) from 

view without deleting it.  
 To mark a section of text or data with a distinct color.  
 The main screen you can view when you first open a website or application.  
 To bring data into a software application from another source.  
 To add new cells, rows, or columns to a spreadsheet.  
 The action or process of enlarging or reducing the view of an object.  
 The blank spaces around the edges of a printed page.  
 To combine multiple cells into one larger cell.  
 To reduce something to the smallest possible size or amount.  
 To move around within a spreadsheet to locate specific data.  
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Unit 1 Word Search with Clues Answer Key 
WORD CLUE 
ACCESS  To open or retrieve a document or file.  
APPEND  To add data to the end of existing content.  
AUDIT  To examine and verify data or records for accuracy.  
BACKUP  A copy of data stored separately for safety and recovery purposes.  
BROWSER  A software application used to access the internet.  
COLUMN  A vertical line of cells in a spreadsheet, labeled with letters.  
CONTEXT  The background or surrounding information that helps make sense of the data.  
CUSTOMIZE  To modify something to suit a particular individual or task.  
DELETE  To remove a cell, row, or column from the spreadsheet.  
DISTRIBUTE  To share or deliver information to a group of people.  
DOCUMENT  A file that contains information, such as a spreadsheet.  
DUPLICATE  To create an exact copy of something.  
EXPORT  To save data in a different format for use in another application or system.  

FORMAT  To change the appearance of text or cells, like making the text bold or changing a 
cell’s color.  

FORMATTING  The arrangement and style of text and data in a document.  
FREEZE  To keep specific rows or columns visible while scrolling through a spreadsheet.  
GRIDLINES  The borders that define the boundaries of cells in a spreadsheet, helping to visually 

separate and organize data.  
HEADER  A row or column that contains labels for the data in the spreadsheet.  
HIDE  To remove the whole worksheet or part of a worksheet (rows and columns) from 

view without deleting it.  
HIGHLIGHT  To mark a section of text or data with a distinct color.  
HOMEPAGE  The main screen you can view when you first open a website or application.  
IMPORT  To bring data into a software application from another source.  
INSERT  To add new cells, rows, or columns to a spreadsheet.  
MAGNIFICATION  The action or process of enlarging or reducing the view of an object.  
MARGINS  The blank spaces around the edges of a printed page.  
MERGE  To combine multiple cells into one larger cell.  
MINIMIZE  To reduce something to the smallest possible size or amount.  
NAVIGATE  To move around within a spreadsheet to locate specific data.  
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Unit 1 Unplugged Activity 
 

Activity 2: Crossword Puzzle 
Solve the crossword puzzle by reading clues and filling in the answer with key terms from the unit.  An 
answer key is provided. 
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Unit 1 Crossword Puzzle 
 
Use the clues to solve the crossword puzzle. 
 

 
 
 
 
 
 
 
 
 

1 2 3

4 5 6

7

8
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21 22
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38 39

40

41 42
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Unit 1 Crossword Clues 
 
Across 
 1 The arrangement and style of text and data in a document.  (10) 
 4 A set of icons and options at the top of the screen that allows you to perform different tasks.  (7) 
 7 To move existing cells to make room for new ones.  (5) 
 9 The borders that define the boundaries of cells in a spreadsheet, helping to visually separate and 

organize data.  (9) 
 11 To share or deliver information to a group of people.  (10) 
 13 To change the magnification level of the spreadsheet view.  (4) 
 15 To revert a document to a previous state.  (7) 
 17 To highlight a row, column, or cell to perform actions on it.  (6) 
 18 A file that contains information, such as a spreadsheet.  (8) 
 21 The background or surrounding information that helps make sense of the data.  (7) 
 23 To modify something to suit a particular individual or task.  (9) 
 24 The main screen you can view when you first open a website or application.  (8) 
 25 To give something a new title.  (6) 
 26 A chronological list of events or changes.  (8) 
 31 To add data to the end of existing content.  (6) 
 32 To move around within a spreadsheet to locate specific data.  (8) 
 34 To mark a section of text or data with a distinct color.  (9) 
 35 Settings that determine what actions users can perform on a shared document.  (11) 
 38 Moving around within the Google Sheets window to access different features.  (10) 
 39 A horizontal line of cells in a spreadsheet, labeled with numbers.  (3) 
 40 To open or retrieve a document or file.  (6) 
 41 The name you give to your spreadsheet to identify it.  (5) 
 42 A row or column that contains labels for the data in the spreadsheet.  (6) 
 
Down 
 1 To keep specific rows or columns visible while scrolling through a spreadsheet.  (6) 
 2 To reduce something to the smallest possible size or amount.  (8) 
 3 To bring data into a software application from another source.  (6) 
 5 A copy of data stored separately for safety and recovery purposes.  (6) 
 6 To remove the whole worksheet or part of a worksheet (rows and columns) from view without 

deleting it.  (4) 
 8 To move up, down, or across a screen to view different parts of a document.  (6) 
 10 A digital document where you can organize data in rows and columns.  (11) 
 11 To create an exact copy of something.  (9) 
 12 To save data in a different format for use in another application or system.  (6) 
 14 The action or process of enlarging or reducing the view of an object.  (13) 
 16 To arrange data in a specific order, like alphabetically or by number.  (4) 
 17 To make a hidden worksheet visible again.  (4) 
 19 To split a joined cell back into the original separate cells.  (7) 
 20 A range of colors or options available for selection.  (7) 
 21 A vertical line of cells in a spreadsheet, labeled with letters.  (6) 
 22 The direction in which a document is printed (portrait or landscape).  (11) 
 27 To match data, ensuring that files are up-to-date across devices.  (4) 
 28 To examine and verify data or records for accuracy.  (5) 
 29 The blank spaces around the edges of a printed page.  (7) 
 30 To remove a cell, row, or column from the spreadsheet.  (6) 
 33 To add new cells, rows, or columns to a spreadsheet.  (6) 
 35 To produce a physical copy of a document from a computer.  (5) 
 36 A group of selected cells in a spreadsheet.  (5) 
 37 Adjusting the size of the content to fit on the printed page.  (5) 
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Unit 1 Crossword Puzzle Answer Key 
 

 
 

Across: 1 FORMATTING, 4 TOOLBAR, 7 SHIFT, 9 GRIDLINES, 11 DISTRIBUTE, 13 ZOOM, 15 RESTORE, 
17 SELECT, 18 DOCUMENT, 21 CONTEXT, 23 CUSTOMIZE, 24 HOMEPAGE, 25 RENAME, 26 TIMELINE, 
31 APPEND, 32 NAVIGATE, 34 HIGHLIGHT, 35 PERMISSIONS, 38 NAVIGATION, 39 ROW, 40 ACCESS, 
41 TITLE, 42 HEADER 

Down: 1 FREEZE, 2 MINIMIZE, 3 IMPORT, 5 BACKUP, 6 HIDE, 8 SCROLL, 10 SPREADSHEET, 11 DUPLICATE, 
12 EXPORT, 14 MAGNIFICATION, 16 SORT, 17 SHOW, 19 UNMERGE, 20 PALETTE, 21 COLUMN, 
22 ORIENTATION, 27 SYNC, 28 AUDIT, 29 MARGINS, 30 DELETE, 33 INSERT, 35 PRINT, 36 RANGE, 
37 SCALE 

F
1

O R M
2

A T T I
3

N G

T
4

O O L B
5

A R I M H
6

A E N P S
7

H I F T

S
8

C E I O D

C K Z M G
9

R I D L I N E S
10

D
11

I S T R I B U T E I T P

U O P E
12

Z
13

O O M
14

R
15

E S
16

T O R E

P L X E A O E

L S
17

E L E C T P G R A

I H D
18

O C U
19

M E N T P
20

T D

C O R N I A S

A W C
21

O N T E X T M F L O
22

H

T O E I E R E

E L R C
23

U S T O M I Z E

U H
24

O M E P A G E A T E T

R
25

E N A M E E T
26

I M E L I N E

N S
27

I T

A
28

M
29

Y O A

U D
30

A
31

P P E N D N
32

A V I
33

G A T E

D E R C N I

H
34

I G H L I G H T P
35

E R
36
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Unit 1: Unplugged Activity  
 
Activity 3: Build a Sheet Challenge 
Objective: Learners will understand the purpose and layout of the Sheets interface by creating a 
paper-based model of the workspace and discussing key tools. 

Materials Needed: 
• Blank paper 
• Pencils and markers 
• Index cards 
 

 
Instructions: 
• Prepare 8–10 index cards. Label each with a fake document title like: - Report Draft - Field Trip 

Plan - Student Roster - Lesson Outline - Club Flyer 
• On your paper, draw a basic version of what you think a Google Sheets window appears like. 

Try to include: 
• A toolbar at the top 
• A grid of rows and columns 
• Menus like File, Edit, View 
• A tab at the bottom for the sheet name 

• Label at least five different parts of your drawing that you think are important. Use arrows to 
point to: 
• Where you would select to bold text 
• Where you might go to change the sheet name 
• Where you might adjust zoom or gridlines 
• Anywhere else you think is useful 

• Now, imagine your spreadsheet is for something you care about (e.g., a class schedule, a game 
leaderboard, or a hobby tracker). 
On your drawing, circle or highlight: 
• What you would customize in your workspace 
• What you’d use most often on the toolbar 

• Pair up or share with your group: 
• What do your toolbars and layouts have in common? 
• What did someone include that you didn’t think of? 

• Teacher Prompt (optional): 
• If you had to find the bold button with your eyes closed, where would your hand go? 
• If I asked you to zoom in, what would you do, and where would you select first? 
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Unit 1: Unplugged Activity  
 
Activity 4: Spreadsheet Simulator 
Objective: Learners will simulate the structure and function of a spreadsheet using classmates or 
paper tiles to physically act out row/column actions like inserting, deleting, hiding, resizing, 
merging, and naming. 

Materials Needed: 
• Paper tiles 
• Chairs or floor markers for standing in a grid (optional) 
• Pencils and markers 
 

 
Instructions: 
• Label a 5x5 grid using paper tiles or sticky notes with row numbers (1–5) and column letters (A–

E). You can place them on the floor, wall, or a desk/table. 
• Each tile represents a cell. Write in a word or number (e.g., “Math,” “Lunch,” “45”) to simulate 

spreadsheet content. 
• Call out or draw cards with challenges like: 

• Insert a new row between Row 2 and 3 
• Delete Column B 
• Merge cells A1 and B1 
• Resize Row 4 to be twice as tall 
• Hide Column D 
• Select all of Row 5 
• Identify the name of the first column 

• Have one learner or team play Spreadsheet Controller and call out tasks. Others must 
complete them accurately on the physical grid. 

• Modifications (Paper Version) 
• Instead of standing in a grid, give learners a worksheet of a blank 5x5 grid. They will: 

• Draw a line to represent hiding columns 
• Cross out deleted rows 
• Shade merged cells 
• Arrow new rows or columns being inserted 
• Label headers to identify row/column names 

• Reflection Questions: 
• What was tricky about merging or resizing? 
• Why is it helpful to know how to hide or unhide data? 
• Which tasks changed how the spreadsheet looked without changing the data? 
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Blank Grid (5x5) 
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1      

2      

3      

4      

5      
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Google Sheets Unit 6 Key Terms   
Term   Definition   

Absolute Cell 
Reference  

A cell reference that remains constant, regardless of where the formula is 
copied or moved.  

Access  To open or retrieve a document or file.  

Accuracy  The quality of being correct or precise.  

Adjacent  Next to or adjoining something else, like cells in a spreadsheet.  

Adjust  To change or modify something to fit new conditions.  

Aggregated  Combined or summarized data from multiple data points into a total or 
average, often used to provide an overview or summary.  

Alphabetically  In order according to the letters of the alphabet.  

Analyze  To examine data in detail to understand it better.  

AND Function  A process that checks multiple conditions and returns TRUE if all conditions 
are met.  

AND Logic  A condition where all criteria must be met.  

Angle  The degree of rotation applied to the text.  

Annotation  A note or comment added to provide explanation or emphasis.  

Append  To add data to the end of existing content.  

Apps Script  A scripting language for light-weight application development in the G Suite 
platform.  

Area Chart  A graph that displays quantitative data, with the space below the line filled 
in.  

Arguments  The inputs required by a function to perform its calculation.  

Array  A range of cells in a spreadsheet that can be used in calculations.  

Ascending Order  A sorting sequence that arranges data from smallest to largest (A-Z, 0-9).  

Audit  To examine and verify data or records for accuracy.  

Autocomplete  A feature that suggests function names and cell references as you type.  

AutoFill  A feature that automatically enters data into cells based on a pattern or 
series.  

Automation  The use of technology to perform tasks with minimal human intervention.  

AVERAGE  A summarization method that calculates the mean of the numbers in a 
specified range.  

Average  The sum of a set of numbers divided by the number of numbers.  

Axis  The horizontal or vertical line on a chart that displays the scale of the data.  
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Axis Labels  Text that describes the categories or values along the horizontal and vertical 
axes of the chart.  

Backup  A copy of data stored separately for safety and recovery purposes.  

Bin Size  The range of values grouped together in a histogram bar.  

Bold  A font style that makes text thicker and darker to stand out.  

Border  A line that surrounds a cell or group of cells in a spreadsheet.  

Browser  A software application used to access the internet.  

Calculate  To find a result using mathematical methods.  

Capitalization  The use of uppercase and lowercase letters in writing.  

Case-Sensitive  A feature that distinguishes between uppercase and lowercase letters.  

Categories  The different groups or variables being compared in the radar chart.  

Category  A classification or grouping of similar items.  

Cell  A single box in a spreadsheet where you can enter data.  

Cell Reference  The identification of a cell or a range of cells in a spreadsheet, such as A1 or 
January (A1:A12).  

Center  To place text or data in the middle of a cell or range of cells.  

Central Tendency  A measure that represents the center or typical value of a dataset.  

Character  A single letter, number, or symbol in text.  

Chart  A graphical representation of data.  

Chart Editor  A sidebar tool in Google Sheets for creating and customizing graphical data 
representations.  

Chart Title  The main heading that describes the content of the graph.  

Circular Reference  A situation where a formula refers back to its own cell, causing an infinite 
loop.  

Cloud Storage  Online repository services that allow you to save and access files over the 
internet.  

Color Scale  A gradient of hues applied to a range of cells based on their values.  

Column  A vertical line of cells in a spreadsheet, labeled with letters.  

Column Chart  A graph that displays data using vertical bars to represent different 
categories.  

Column Letter  The character at the top of each column that identifies it.  

Column Width  The horizontal space allocated for displaying the contents of a cell.  

Column-Locked 
Reference  

A reference where the column is fixed and the row is relative.  
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Comparison  The act of examining two or more items to note similarities and differences.  

Complex Conditional 
Formatting  

Applying multiple formatting rules based on different criteria to a range of 
cells.  

Component  A part of a larger whole.  

Condition  The specific requirement that must be met for the formatting to be applied.  

Condition (filter) A rule that data must meet to be included in the filtered results.  

Conditional 
Calculation  

A computation that only includes data meeting certain criteria.  

Conditional 
Expression  

A statement that evaluates to either TRUE or FALSE and can be used to filter 
data.  

Conditional 
Formatting  

A feature that automatically applies formatting to cells based on their 
content.  

Confirmation Dialog 
Box  

A pop-up window that asks you to verify an action.  

Consistency  The uniform appearance and style across a spreadsheet.  

Consistent  Always behaving or appearing the same way.  

Consolidate  To combine multiple pieces into one.  

Context  The background or surrounding information that helps make sense of the 
data.  

Context Menu  A list that appears upon right-clicking, offering additional options and 
actions.  

Copy  To duplicate data from one location to another.  

Count  To determine the number of items.  

COUNT  A function that determines the number of cells containing numbers in a 
specified range.  

COUNTIF Function  A formula that totals the number of cells in a range that meet a specific 
criterion.  

Criteria  Specific conditions or values used to filter data.  

Criteria Range  A range that defines the conditions used for filtering data.  

Criterion  The condition that must be met for a cell to be counted.  

Cumulative  Accumulating or progressively increasing through successive additions.  

Currency  The system of money in general use in a particular country.  

Current Date  The present date, automatically updated.  

Custom Error 
Message  

A note displayed when invalid data is entered.  
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Custom Formula  A user-defined expression used to specify conditions for conditional 
formatting.  

Customize  To modify or adjust something to fit personal preferences or needs.  

Customized  Tailored to specific needs or requirements.  

Data  Information that is collected and used for analysis.  

Data Analysis  The process of examining data to discover useful information.  

Data Integrity  The accuracy and consistency of data over its life cycle.  

Data Labels  Descriptions that display the value of each information point directly on the 
chart.  

Data Point  An individual value or piece of information within a dataset.  

Data Range  The group of cells that contains the information displayed in the chart.  

Data Retrieval  The process of obtaining information from a database or dataset.  

Data Series  A set of related information points plotted on a chart.  

Data Validation  The process of ensuring data is accurate and meets certain criteria.  

Database  A structured range of cells that includes headers and information.  

Dataset  A collection of related information organized in rows and columns.  

Date  A specific day, month, and year.  

Day  The numeric day of the month.  

DCOUNTA  A function that totals the number of non-empty cells in a database that 
meet specified criteria.  

Debug  To find and fix errors in a program or formula.  

Decimal  A number that includes a fraction represented by digits to the right of the 
decimal point.  

Decimal Places  The number of digit positions to the right of the point in a number.  

Decrease Decimal 
Places  

An option to display fewer digits after the point in a number.  

Delete  To remove a cell, row, or column from the spreadsheet.  

Delimiter  A character used to separate items in a list.  

Descending Order  A sorting sequence that arranges data from largest to smallest (Z-A, 9-0).  

Detailed Data  The underlying information that contributes to summarized or aggregated 
values in a pivot table.  

Dialog Box  A small window that prompts the user to enter information or make a 
selection.  

Dictionary  A collection of words recognized by the Spell check tool.  
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Difference  The result of a subtraction operation.  

Display Settings  
Options that control the appearance of the workspace, such as showing or 
hiding elements like gridlines and the formula bar.  

Distribute  To share or deliver information to a group of people.  

Dividend  The number that is to be divided.  

Division  A mathematical operation where one number is divided by another.  

Divisor  The number by which another number is divided.  

Document  A file that contains information, such as a spreadsheet.  

Dollar Sign ($)  A symbol used in absolute references to lock the column and/or row.  

Donut Chart  A pie graph with a hole in the middle, making the graph a ring shape.  

Drag  To select and hold the mouse button while moving the object to a new 
location.  

Drawing  A visual representation created using shapes, lines, text, and images.  

Drill Down  To explore detailed data that makes up a summary value in a pivot table.  

Dropdown Menu  A list of options that appears when you select certain icons or their down 
arrows.  

DSUM  A function that sums values in a database that meet specified criteria.  

Duplicate  To create an exact copy of something.  

Duplicates  Values that appear more than once in a dataset.  

Duration  The length of time something lasts.  

Dynamic  Capable of changing or being adjusted based on input or conditions.  

Edit  To make changes to the existing text or data in a cell.  

Edit History  A record of all changes made to a specific cell, including who made the 
changes and when.  

Editable  Allowing users to make changes to the content.  

Efficiency  The ability to perform tasks quickly and correctly.  

Elaborate Filters  Complex criteria used to refine data extraction.  

Entries  Individual items or values in a dataset.  

Error  A message indicating a problem with a formula or data.  

Error Checking  Identifying and handling errors in data or formulas.  

Error Message  An indication that something is wrong with the formula or data.  

Exact Match  A condition where the lookup value must exactly match a value in the 
lookup range.  
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Exponential Input  A way to represent numbers using a base and an exponent, typically in 
scientific notation.  

Export  To save data in a different format for use in another application or system.  

Extract  To retrieve specific data from a larger set.  

Field  A specific category or column in a dataset or pivot table that contains a 
particular type of information that can be used to organize and summarize 
data.  

File Tab  A menu at the top left corner that lets you open, save, and print documents.  

File Type  The format of a file, such as .xls, .csv, or .txt.  

Fill Color  The background shade of a cell in a spreadsheet.  

Fill Handle  A small square at the bottom-right corner of a selected cell used to copy data 
or continue a series.  

Filter  A tool that allows you to display only the data that meets specific criteria.  

FILTER  A function that extracts data that meets specified criteria.  

Filter Criteria  Conditions used to filter data in a function.  

Filter View  A feature that allows you to create and save multiple refined or altered 
displays of your data without changing the original dataset.  

Filtered List  A subset of data that meets specified criteria.  

Filters  Criteria used to include or exclude data from the pivot table.  

Find  To locate specific text or values in a spreadsheet.  

Fit to Data  An option that automatically adjusts the row or column size to match the 
content within it.  

Flatten  To convert multiple rows or columns into a single column.  

Font Color  The shade of the text in a spreadsheet.  

Font Size  The height and width of the text characters in a spreadsheet, usually 
measured in points.  

Format  To change the appearance or layout of data in a spreadsheet.  

Format Painter  A tool used to copy and apply formatting from one cell or range to another.  

Formatting  The appearance of the data in a cell, including font, color, and cell borders.  

Formula  A mathematical expression used to perform calculations on data in a 
spreadsheet.  

Formula Bar  
The area in Google Sheets where you can view and edit the formula or 
content of the selected cell.  

Formula Conditional 
Formatting  

Applying formatting rules based on custom formulas.  
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Freeze  To keep specific rows or columns visible while scrolling through a 
spreadsheet.  

Frequency  The number of data points that fall within a specific range.  

Function  A predefined formula that simplifies complex calculations, such as SUM or 
AVERAGE.  

Function Code  A numerical key that specifies the type of calculation to perform in the 
SUBTOTAL function.  

FV (Future Value)  The value of an investment at the end of a specified period.  

Google Chrome  A web browser required for enabling offline access in Google Drive.  

Google Drive  A file storage service that includes Google Docs, Sheets, and other apps.  

Gradient  A gradual blend between two or more colors.  

Graphic  An image or chart inserted into a spreadsheet.  

Gridlines  
The borders that define the boundaries of cells in a spreadsheet, helping to 
visually separate and organize data.  

Group  To combine similar items into a single category.  

Handles  Small squares that appear around a selected object, used to resize or move 
the object.  

Header (Table) The top row of a table that labels the columns.  

Header  A row or column that contains labels for the data in the spreadsheet.  

Header Row  The top line of a table that labels the columns.  

Hide  To remove the whole worksheet or part of a worksheet (rows and columns) 
from view without deleting it.  

Highlight  To mark a section of text or data with a distinct color.  

Histogram  A chart that illustrates the distribution of numerical data by displaying the 
frequency of data points within specific ranges.  

Holiday  A day set aside by custom or by law on which normal activities, especially 
business or work, are suspended.  

Homepage  The main screen you can view when you first open a website or application.  

Horizontal Align  The position of text or data across the width of a cell.  

Hour  A unit of time equal to 60 minutes.  

HYPERLINK  A function that creates a selectable link to a specified URL or cell reference.  

Identifier  A unique symbol or name used to identify something.  

IF Function  A formula that performs a logical test and returns one value for a TRUE result 
and another for a FALSE result.  

Ignore  To disregard a spelling error and move to the next one.  

Import  To bring data into a software application from another source.  
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Increase Decimal 
Places  

An option to display more digits after the point in a number.  

Index Number  A number that represents the position of a column in a range.  

INDIRECT  A function that returns a cell or range reference specified by a text string.  

Input  To enter data into a cell in a spreadsheet.  

Insert  To add new cells, rows, or columns to a spreadsheet.  

Instance  An occurrence of the specified text or value in the spreadsheet.  

Integer  A whole number without a fractional component.  

Integrity  The accuracy and consistency of data over its life cycle.  

Interactive  Allowing user input to dynamically change the displayed information.  

Interactivity  The quality of allowing interaction or engagement with the content.  

Interest Rate  The percentage charged on a loan or earned on an investment.  

Italic  A font style that slants text to the right for emphasis.  

Label  A text entry used to identify data in a spreadsheet.  

LARGE Function  A function that returns the largest value in a data set.  

Legend  An area of a chart that explains the symbols and colors used.  

Line Style  The appearance of the lines connecting data points (e.g., solid, dashed).  

Link Label  The text displayed in the cell that acts as the selectable link.  

Logical Function  A function that returns either TRUE or FALSE based on a condition.  

Logical Test  A comparison that evaluates TRUE or FALSE.  

Lookup Value  The value you are searching for in the data.  

Lowercase  Small letters (e.g., a, b, c).  

Macro  A recorded set of actions that can be replayed to automate tasks.  

Magnification  The action or process of enlarging or reducing the view of an object.  

Margins  The blank spaces around the edges of a printed page.  

Match  A condition where two items are exactly the same.  

MAX Function  A formula that returns the highest value in a specified range of cells.  

Maximum  The largest value in a set of numbers.  

Maxpoint  The highest value in the selected range.  

Mean  The sum of a set of numbers divided by the count of numbers in the set.  

Merge  To combine multiple cells into one larger cell.  

Midpoint  A value between the minimum and maximum.  
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MIN Function  A formula that returns the lowest value in a specified range of cells.  

Minimize  To reduce something to the smallest possible size or amount.  

Minimum  The smallest value in a set of numbers.  

Minpoint  The lowest value in the selected range.  

Minute  A unit of time equal to 60 seconds.  

Mixed FILTER  A function that combines multiple conditions using both AND and OR logic.  

Mixed Reference  A reference that locks either the column or row, but not both.  

Month  The numeric representation of the month.  

Multiple Conditions  More than one criterion used to filter data.  

Multiplication  A mathematical operation where one number is multiplied by another.  

Multiply  To increase a number by another number.  

Named Range  A descriptive title assigned to a specific group of cells.  

Navigate  To move around within a spreadsheet to locate specific data.  

Navigation  
Moving around within the Google Sheets window to access different 
features.  

Nearest  The closest value according to a specified criterion.  

Nested IF Function  An IF formula embedded within another IF formula to evaluate multiple 
conditions.  

Non-Continuous 
Range  

Multiple areas that are not adjacent to each other.  

Notation  A system of symbols used to represent numbers, positions, or elements.  

Numerical  Related to numbers.  

Numerically  In order according to numbers.  

Offline Mode  The ability to use a service without an internet connection.  

OR FILTER  A function that extracts data meeting at least one of multiple conditions.  

OR Logic  A condition where at least one of the criteria must be met.  

Order  The sequence in which rules are applied, which can affect the final 
formatting.  

Organized  Arranged in a systematic way.  

Orientation  The direction in which a document is printed (portrait or landscape).  

Palette  A range of colors or options available for selection.  

Paste  To insert copied data into a new location.  

Paste Formats Only  An option to apply only the formatting of copied cells without altering the 
data or formulas.  
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Paste Special  A feature that allows you to insert copied data in various ways, such as 
inserting its values only or formatting only.  

Pattern  A repeated or regular arrangement.  

PDF (Portable 
Document Format)  

A file format used to present documents consistently across different 
devices.  

Percentage  A way of expressing a number as a fraction of 100 using a symbol.  

Periodic Payment  Regular payments made over time, such as monthly loan payments.  

Permissions  Settings that determine who can view or edit parts of a Google Sheet.  

Pie Chart  A circular graph divided into slices to illustrate numerical proportions.  

Pivot Table  A tool that summarizes and analyzes data by grouping and organizing it into 
a dynamic chart.  

Pivot Table 
Columns  

A category that represents unique values from specified data, creating 
columns in the chart.  

Pivot Table Rows  A category that represents unique values from specified data, creating rows 
in the chart.  

Position  The location of a character within a text string.  

Presentation  The way in which data is displayed and formatted in a chart.  

Print  To produce a physical copy of a document from a computer.  

Print Area  The specific range of cells selected to be printed.  

Product  The result of multiplying numbers together.  

Program 
Permissions  

The authorization granted to a program or script to access certain data or 
features.  

Proportionally  Adjusting the size while maintaining the same width-to-height ratio.  

Protect  To restrict editing access to certain parts of a spreadsheet.  

Protect Range  A feature that restricts access to specific ranges or entire sheets, preventing 
unauthorized viewing or editing.  

PV (Present Value)  The current value of a sum of money to be received in the future.  

Quantity  The amount or number of something.  

Query  A request to retrieve specific data from a table.  

Quotient  The result of a division operation.  

Radar Chart  A graph that displays multivariate data in a circular format, allowing for 
comparison across multiple categories.  

RAND  A function that generates a random decimal number between 0 and 1.  

Random Number  A number generated without a predictable pattern, often used in 
simulations.  
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Range  A group of selected cells in a spreadsheet.  

Rank  The position of a value relative to others in a list.  

Readability  The ease with which text can be viewed and understood.  

Reference  A specific mention of data from another workbook used in calculations or 
display.  

Regular Expressions  Advanced search patterns used for complex text searches.  

Relative Cell 
Reference  

A cell reference that adjusts based on the position of the formula.  

Relative Position  The location of a value in relation to other values in a list.  

Relative Reference  A cell reference that changes relative to the position of the cell in which it is 
used.  

Rename  To give something a new title.  

Reorient  To change the direction or arrangement of data.  

Replace  To substitute specific text or values with new ones.  

Replay  To perform a sequence of actions again.  

Resize  To change the dimensions of a graphic or object.  

Restore  To revert a document to a previous state.  

Return Value  The result produced by a function.  

Rounding  The process of reducing the number of digits in a number while keeping its 
value close to the original.  

Row  A horizontal line of cells in a spreadsheet, labeled with numbers.  

Row Height  The vertical size of a row in a spreadsheet.  

Row Number  The digit on the left side of each row that identifies it.  

Row-Locked 
Reference  

A reference where the row is fixed and the column is relative.  

Rule  A specific condition and formatting style applied to a range of cells.  

Scale  Adjusting the size of the content to fit on the printed page.  

Script  A set of instructions executed by a computer program.  

Script Editor  The interface where you can view and edit the code behind a macro.  

Scroll  To move up, down, or across a screen to view different parts of a document.  

Search Bar  A tool that helps you browse and select files from your storage.  

Security  The measures taken to protect data from unauthorized access or 
alterations.  

Select  To highlight a row, column, or cell to perform actions on it.  
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Semi-Absolute 
Reference  

A cell reference that locks either the column or row but not both.  

Sequential  Arranged in a series or order.  

Share Button  
An option to select that lets you distribute your document to others and set 
their permissions.  

Sheet  An individual page within a Google Sheets document.  

Sheet Tab  The labeled tag at the bottom of the Google Sheets window that represents 
each page in the document.  

Shift  To move existing cells to make room for new ones.  

Show  To make a hidden worksheet visible again.  

Show Formulas  A feature that displays the formulas used in cells instead of the resulting 
values.  

Sidebar  A vertical panel that appears on the side of the screen, providing additional 
options and settings.  

Sign In  To enter your username and password to access your account.  

Slice  A segment of a pie chart representing a category's proportion of the whole.  

Sort  To arrange data in a specific order, like alphabetically or by number.  

Sparkline  A small, basic chart that fits within a single cell to display data trends.  

Sparkline Options  Additional parameters that customize the appearance and behavior of the 
sparkline.  

Spell Check  A tool that identifies and corrects spelling errors in a document.  

Spreadsheet  A digital document where you can organize data in rows and columns.  

SQL  A programming language used to manage and manipulate databases.  

Standardize  To make something consistent or uniform.  

String  A sequence of characters or text.  

Subset  A portion of a larger set of data.  

Substring  A part of a string of characters.  

SUBTOTAL  A function that performs calculations on a filtered list or range of data.  

Subtraction  A mathematical operation where one number is taken away from another.  

Suggestion  A proposed correction for a spelling error.  

SUM Function  A formula that adds all the numbers in a specified range of cells.  

SUMIF Function  A formula that adds numbers in a range based on specific criteria.  

Summarize  To present the main points or key details of data in a concise form.  

Symbol  A character or sign used to represent something, such as a dollar sign or Euro 
sign.  
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Sync  To match data, ensuring that files are up-to-date across devices.  

Syntax  The structure of a formula, including the function name and arguments.  

Table  An arrangement of data in rows and columns.  

Text  Written or printed words.  

Text Rotation  The angle at which data is displayed within a cell.  

Text String (String)  The data in a spreadsheet, comprised of letters (words), symbols (e.g., the 
dash or the number sign), numbers or special characters.  

Text Wrapping  A feature that makes text fit within the cell by adjusting the cell height.  

Threshold  A value or limit that must be met or exceeded.  

Time Value  A representation of time, including hours, minutes, and seconds.  

Timeline  A chronological list of events or changes.  

Timestamp  A specific point in time, represented in hours, minutes, and seconds.  

Title  The name you give to your spreadsheet to identify it.  

Toolbar  A set of icons and options at the top of the screen that allows you to perform 
different tasks.  

Tooltip  A small, informational box that appears when you hover over or interact with 
certain elements.  

Top Values  The highest data points in a range of data. 

Total  The final amount obtained by adding numbers together.  

TRANSPOSE  A function that switches the rows and columns of a selected range of cells.  

Truncate  To shorten by cutting off.  

Underline  A font style that adds a line beneath the text.  

Unified  Made into a single unit.  

UNIQUE  A function that extracts unique values from a range, removing any 
duplicates.  

Unit of 
Measurement  

A standard quantity used to specify the amount of something (e.g., days, 
months, years).  

Unmerge  To split a joined cell back into the original separate cells.  

Uppercase  Capital letters (e.g., A, B, C).  

URL  The web address of a resource on the internet.  

Value  A number or data point in a cell.  

Values  The actual numbers or text in a cell, without any formulas or formatting.  

Version History  A feature that tracks and stores previous copies of a document.  

Visible  Able to be viewed.  
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Weekday  A day of the week.  

Weighted Average  An average that takes into account the relative importance of each value.  

Whole Number  A number without fractions or decimals.  

Workbook  A file containing multiple sheets in Google Sheets.  

Workday  A day typically considered as a working day, excluding weekends and 
holidays.  

Year  The numeric representation of the year.  

Zoom  To change the magnification level of the spreadsheet view.  
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